
Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                  Trainers Manual  
 

Copyright  2004  i3 Training Services  Inc. 

Trainer Notes Day 1  Set-up Checklist 
 
 

Prior to Arriving 
 Locate and pack a copy of “Where the Wild Things Are”, “Chicka Chicka Boom 

Boom” and “Brown Bear, Brown Bear What Do You See.” 
 Create the coconut tree poster for the Chicka Chicka Book Activity 
 Create an laminate alphabet cards to hand on the coconut tree 
 Pack the stuffed animal or print-outs of book characters to help set the mood. 

You will need Max and the Wild things at a minimum. 
 Create nameplates for participants  
 Create “Not Yet” and “Done” chart. Purchase or locate clothespins to use with this. 
 Pack music CDs to set an upbeat training mood. 
 Pack floppy disks in case shared drive space is not available. 
 Create Young Learners Are Kidspiration template and save it to a disk. 

 
 
Once You Arrive 

 Test to make sure that you can download the software for the Learning Letters 
activity. It is the Letter Machine Activity from the Bailey’s Bookhouse software. 
Riverdeep allows users to download portions of the software to try it for free. 
http://www.riverdeep.com/products/downloads/free_downloads.jhtml 

 Check the web site for resources, templates ect. that you  may need to teach the 
day. Currently they are on 
http://www.ikeepbookmarks.com/browse.asp?folder=208809 

 Check the following software on each machine and make sure that it opens and has 
the appropriate settings: Kidspiration, Word, Powerpoint, Graph Club, Kid Pix. 

 Check Internet access on each machine and see if you can add the Baby Bytes link 
to the favorites for the training session 

 Test printing from each machine and make sure there is paper and ink to print 
 Make sure that each machine can access a shared folder or drive on the server. 

Create a folder on the shared drive to save material to. 
 Put student books together and place one at each computer you will be using 
 Print sign-in sheet and set out 
 Create nameplates for each person and set them out. 
 Set out group management tool poster as well as individual management tools (red 

cups) 
 Set out sticky notes and markers for each computer 
 Hang up the Chicka Chicka Boom Boom poster 
 Set out the stuffed animal book characters  
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 Make sure that your computer can project and that the first activities of the day 
are open and minimized on the screen. 

 Make sure Real Player is loaded on the teaching machine for the Anansi 
activity.http://www.real.com/realplayer.html 
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Trainer Notes  All days   Routine Tasks 
 

 Check end of the day notes from the previous day for anything that needs to be 
prepared prior to students arriving 

 Check supplies such as sticky notes, markers and candy. 
 Make sure to read over the email reflections that participants send so that you can 
respond to concerns or positives either whole group or privately. 

 
Technology Management Strategy at Student Workstations: 
Red cups – Give each participant a red cup to place on or beside the computer.  The red 
cup will be used to indicate the need for help.  Participants will be asked to put the red 
cup up on the computer when they need help.  The trainer will use the red cup, saying 
cups up or cups down, to indicate when participants have finished a process during the 
lesson. 
 
Kiosk: 
There is a kiosk, created in PowerPoint, for each day of the training.  Have this playing 
as the participants enter the training room.  Here they will find the daily objectives, 
software used, daily assignments including the daily diary topic and any information the 
trainer wants them to have.  Update before each training. Kiosks can be downloaded 
from the trainer web site at http://www.i3forteachers.com/readyforreading/  
 
Music: 
Have a music CD playing as participants enter the room and are participating in the 
morning assignments.  
 
E-Mail & “Sites of the Day”: 
Trainers send email messages to the participants each day after Day 1.  The suggested 
messages can be found with the Trainer materials.  You will be sending them an email 
that has questions pertaining to the reading assignments and several internet “Sites of 
the Day.” These are general reference sites for teachers. Spend a few minutes each 
morning going over the sites to familiarize participants with them.  Emails and “Sites of 
the Day” can be found on the trainer CD can be downloaded from the trainer web site at 
http://www.i3forteachers.com/readyforreading/ 
 
Daily Diary: 
Participants are asked to reflect in a daily diary.  After day 1 this is completed as the 
participants arrive.  It is part of the daily assignments listed on the kiosk.  Daily Diary 
topics can be found with the Trainer materials.  Each day participants will be asked to 
group share their daily diary reflections.  After group share the leader of the day will 
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report to the whole group what was discussed.  This is a time for the trainer to 
understand what issues the participants are facing both in the training session and in 
their classrooms.  The trainer will lead the discussions providing input on the “hot” 
topics. 
Daily Diary topics can be found on the trainer CD can be downloaded from the trainer 
web site at http://www.i3forteachers.com/readyforreading/  
 
 
 
Professional Readings - 
Daily participants are required to read from the appendix of the notebook. Questions 
regarding the readings are part of the email activity.  
Day 1 - Appendix Page 1-7 
Day 2 - Appendix Page 8-16 
Day 3 - Appendix Page 17-24 
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Good Morning! 
Day 1 

Technology Integration 
 
 
 

 
 
 
 
 
 
 
 
“Taken together the tools of technology offer flexibility and 
individualization to help reach an increasingly diverse student population 
provide experiences that engage their interest, and respond to a range of 
needs. To be successful, the use of these tools must take into 
consideration children’s needs to be active and involved, learning with both 
their bodies and their minds.” 

“Learners, Language and Technology: Making Connections that Support Literacy” 
Northwest Educational Technology Consortium 

http://www.netc.org/earlyconnections/pub/index.html 
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Trainer Notes Day 1  Agenda 
 
 

Beside each activity is listed the page numbers in the participant’s notebook that the activity 
refers to as well as a rough idea of the time it should take to do the activity. 
 

 Reading Fun Activity (page 5) 15 minutes 

 Early Learners Are… 30 minutes 

 Where the Wild Things Are (pages 6-8) 70 minutes 

 Character Favorites Graph (pages 9-12) 60 minutes 

 LUNCH 

 Learning Letters (pages 18-22) 30 minutes 

 Brown Bear (pages 24-25) 60 minutes 

 Two Anansi Tales (pages 34-36) 45 minutes 

 Daily Reflection  20 minutes 

 Email Set Up 15 minutes 

 Brain Check (pages 45) 10 minutes 
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The Research – Day 1 - page 3 
 

Starting Day 1 
 

 Greet folks and point out the kiosk to them. 
 Once folks have signed in and are settled have them read the material on pages        
3 & 4.  

 Take a few minutes to highlight portions of what they read. Make it clear that this 
experience was designed to be a catalyst for change and not a boot camp. Make it 
clear that they will leave with new ideas and an understanding of how and why 
technology is important. The focus is making them more comfortable with technology 
not to train them for a marathon. 
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The Research 
 
There is a growing body of research that supports the use of technology with young 
children. The National Association of Educators of Young Children (NAEYC) as early as 
1996 wrote a position statement in which they detailed seven points about technology 
usage. The points they addressed are: 

1. the essential role of the teachers in evaluating appropriate uses of technology 
2. the potential benefits of the appropriate uses of technology in early childhood 

programs 
3. the integration of the technology into the typical learning environment 
4. equitable access to technology, including children with special needs 
5. stereotyping and violence in software 
6. the role of teachers and parents as advocates 
7. the implications of technology for professional development. 

Technology and Young Children- Ages Three through Eight NAEYC 1996 
 

For each point, NAEYC describes a role and guidelines for how and in what ways 
technology should be used.  There has been a lot of research since that time and a lot of 
new technology developments. Douglas Clements in “First Experiences in Science, Math, 
and Technology” writes, “Research has moved beyond the simple question of whether 
computers can help young children learn. They can. What we need to understand is how 
best to aid learning, what types of learning we should facilitate, and how to serve the 
needs of diverse populations. In some innovative projects, computers are more than 
tools for bringing efficiency to traditional approaches. Instead they open new and 
unforeseen avenues for learning.” 

“First Experiences in Science, Mathematics and Technology” from Dialogue on Early Childhood Science, 
Mathematics and Technology Education 

 
Our Beliefs 
This training has been researched, designed and implemented based on points that 
NAEYC raises as well as Dr. Clements research findings. However, this training has no 
legal or other informal relationships with these entities.  i3 firmly believes that 
technology usage should be developmentally appropriate and should be integrated into a 
well-designed program which addresses the needs of the whole child. Technology will not 
replace excellent teaching and hands on learning. However, technology can enhance and 
support children’s learning and provides experiences not readily available in children’s 
environment. 
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The Research – Day 1 - page 4 
 

NOTES
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How will my teaching change if I use technology? 
Learning something new requires change. Some of the changes that people have 
experienced as they began to use technology with students are: 

• a shift from technology as a reward or play thing to the deliberate use of 
technology with students 

• a shift from a limited or episodic use of technology to the inclusion of technology 
into planning for everyday instruction 

• the development of a vision of the role that technology can play in the learning of 
young children 

• the development of a new role as a guide rather than sole purveyor or information 
in a classroom 

 
Will this happen overnight? 
No, change takes time. In this training you will be exposed to new ideas and new 
technologies. Will all of them be right for you and your students immediately? No, begin 
using your new knowledge slowly developing a comfort level with different portions of it. 
Over time you will find that what once was unthinkable is now happening. We are also 
cognizant that many pre-k classrooms are not equipped with the latest and greatest 
technology hardware and software. Frankly, that might be a good thing up until now. We 
are firm believers that we should for have an understanding of how the tools should are 
and should be used before we spend thousands of dollars purchasing tools that might 
not get used. This training will provide you with a solid foundation in which to build and 
make decisions about equipment and resource acquisition.  
 



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                  Trainers Manual  
 

Copyright  2004  i3 Training Services  Inc. 

Reading Fun – Day 1 - page 5 
 

Reading Fun Activity 
Trainer Notes for Reading Fun 
1. Welcome everyone and tell the group that we are going to dive into the day by doing 

a brief activity and that we will introduce ourselves after it. 
2. Have students take out the Reading Fun sheet on page 5 and direct them to say 

hello to their team members and then have them initial the ones on the Reading Fun 
sheet that they can do. If there are  a lot of people have them initial only one item 
per sheet. If the group is small let them initial as many as they want. 

3. Do this with students and allow enough time so that everyone gets to meet and 
greet each other.  

 
Trainer: End of Activity Discussion 

1. When people have sat down go over what they have learned and do introductions. 
For large groups have them raise hands to show who did or could have signed for 
some of the key ideas.  

2. Introduce yourself last and give a bit of detail about your background. 
3. Have them look at their notebook and explain that each day has a theme and that 

today we are focusing on technology integration. State that in order to 
understand the challenges of integrating technology they will be doing a activities 
throughout the day to get a feel for how to manage a technology-connected 
activity as well as ideas for what might be appropriate for their kids. 

4. Read the quote on the title page of day 1- use the last line to segue into the next 
activity 

 
Trainer Notes for Early Learners Are… 

1. Tell participants that young learners have particular needs. Bring up the 
minimized Kidspiration template and have the group describe young learners. Add 
their ideas to the templates. 

2. Demonstrate how to add ideas and have participants come up one and a time and 
share their ideas.  

 
Trainer: End of Activity Discussion for Early Learners Are… 

1. When everyone has had a chance to add to the original template. Talk with them 
about how they just used one computer to have a discussion and organize 
information. 

2. Tell them in the next activity they will become more familiar with this program 
3. Break after this activity for 5-minute stretch and restroom break 
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Reading Fun 
 

Get up and chat with your colleagues and find out a little more about them. Ask if they 
have done any of these things and then have them initial in any box. Be sure to get them 
to tell you about it. 
 

 
 
Has been to 

hear a 
children’s  

author speak. 
 
 

 
 

Only reads 
during the 
summer. 

 
 

Finishes a 
book even if 
she doesn’t 

like it. 

 
 
Chooses books 
by the cover. 

 
Has a 

personal 
collection of 
children’s 
books. 

 

 
Has stuffed 
animals that 

are book 
characters. 

 
Has a public 
library card 
and uses it. 

 
Stays up late 

at night 
reading if the 
book is really 

good. 

 
Checks the 
bestsellers 
list to see 

what is hot. 
 
 

 
Prefers 

reading the 
book to seeing 

the movie. 

 
Can name 

three books 
by a favorite 

author. 

 
Participates 
 in a book 

club. 
 

 
Can stay for 
hours in the 

local 
bookstore. 

 
 

 
Has a favorite 
all time book 
that she re-

reads. 

 
Is willing to 
name her 
guilty book 
pleasure. 

 
Receives a 
newsletter 

with 
information on 

children’s 
books. 



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                  Trainers Manual  
 

Copyright  2004  i3 Training Services  Inc. 

Where the Wild Things Are – Day 1 - page 6 
 

Trainer Notes for Where the Wild Things Are 
1. Have teachers read the essential questions for this activity. Explain that the 

essential questions for them describe what you hope they will get out of the 
lesson. Then explain that the essential question for the students is what you hope 
the student get out of the lesson.  

2. Have someone read the essential question and learning goals for the lesson. Ask 
teachers where technology is mentioned? They should point out that it isn’t part 
of the learning goals for the students.  

3. Tell them that during this lesson with Where the Wild things are they will use 
three pieces of software to explore a story in greater detail but that the focus is 
on the story and understanding story components. Technology serves curriculum. 

 
 

Trainer: End of Activity Discussion Where the Wild Things Are 
1. Tell participants that this is not something you would do at the start of the year 

with young students. This is activity that you would do after students were used 
to handling themselves on the computer a little bit. 

2. Discuss color-coding the keys on the computer to help young learners. For 
instance little dots of color on the keyboard allow students to associate their 
space bar with the blue dot. 

3. Ask teachers how else they might use the Kid Pix software and give them several 
suggestions such as practice name spelling, stamping pictures to go with letters or 
sounds, or drawing and labeling basic pictures. 

4. Go back to the essential questions for teachers and see if they were addresses. 
5. Conclude by asking participants what adaptations they would make in doing this 

type of activity. Be prepared for anything if you ask this. 
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Where the Wild Things Are 
 

Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I effectively use one computer as an instructional tool in 
my classroom? How can a scan converter facilitate 
instruction? How do I use Kidspiration? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Whole Group 
Instruction  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
PowerPoint and 
Scan 
Converter 
 
 
 
 
 
 
 

Essential Question for the Lesson: 
Can students identify key components of a story including the 
characters, setting, main event, and ending? Can students put 
the sequence of events in order? 
 
Learning Goals: 

• Students will listen and participate in the activity. 
• Students will respond to questions. 
• Students will contribute to the conversation. 
• Students will recall events in the story. 

 
Materials: 
A copy of “Where the Wild Things Are” by Maurice Sendak. 
 
Technology Connections: 
Students will work with the teacher to complete an activity 
using Kidspiration and work independently using Kid Pix to 
create their own wild thing. 
 
Procedures: 

1. Organize the students so they all can see the 
computer. Introduce the activity by telling the 
students that you have a book to read to them and will 
be using the computer to talk about the story when we 
are done. 

2. Use the PowerPoint to preview some of the new 
vocabulary in the story. Discuss the meaning of the 
words and have the students when appropriate act the 
words out. Tell the students that when they hear some 
of those words in the story you want them to give you a 
thumbs up to show they are listening carefully. 
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Where the Wild Things Are – Day 1 - page 7 
 

NOTES 
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Kidpsiration 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Read “Where the Wild Things Are” slowly taking time 
to look at the pictures and discuss what is happening. 
Pause when you read a vocabulary word you introduced 
to see if the kids give you thumbs up. 

4. Break at this point before beginning the computer 
activity. When you begin again, show the pictures of 
the story and have the students tell you what is 
happening in the story. 

5. Open Kidspiration and create a box labeled Title and 
three boxes attached to it:  characters, setting, and 
main events. Tell the students that all stories have 
some things in common.  They are going to learn about 
them by telling you about the story they just read. 

6. Click in the Title box and ask the students to tell you 
the title of the story. Type it into the title box. 

7. Ask the students who was in the story? They will tell 
you Max and the wild things. Click on the character 
box, read the word “Characters” to the students and 
tell them that every story has characters in it. Fill in 
Max and the wild things. You may want to take time to 
have the students give the beginning sounds of the 
words. 

8. Next ask students where did the story take place? 
They should tell you Max’s home or room and the land 
where the wild things live. Click on setting and read the 
word “setting.” Tell the students that every story 
takes place somewhere.  

9. Finally, ask students what happened in the story. Click 
on the term “Main Events” and read it. Add 2-3 boxes 
off the main event and write brief summaries using 
simple words of the student’s descriptions on the story. 

10. Before leaving this template, go back and ask student’s 
questions like “Which word describing Max begins with 
a ___?”  

11. A second way to review this is to see if the students 
are able to apply those words to another story you have 
read recently. 

12. Again, determine if your students need a break or are 
ready to proceed to the next activity. If they are 
ready, go back to the Kidspiration template and ask 
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Where the Wild Things Are – Day 1 - page 8 
 

NOTES 
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Kid Pix 

them to describe Max. Add 2-3 boxes to Max’s name 
that describe him. Do the same for the Wild Things. 
Use the book with this activity so that the students 
can refresh their memory. 

13. Explain that how a character looks and acts and thinks 
makes a big difference in a story.  Tell them that they 
are going to draw themselves and a wild thing using Kid 
Pix. 

14. Open the program and go into Kid Pix.  
Introduce the line tool, the eraser and the paint 
bucket. Have the students draw a picture of a wild 
thing they would like in their story. If appropriate, 
have the students type their name on the picture using 
the typewriter tool and print them out.  

15. To complete this activity, meet with each child 
individually and ask him/her to tell you a sentence 
describing their wild thing. Write the sentence on the 
back of the picture for the child or allow the child to 
write the sentence using invented spelling.  Ask the 
students if their wild thing is the same or different 
from the ones in the story we read. 

16. If teachers choose to, they can go back and bring the 
PowerPoint up to review the vocabulary one more time 
having the students explain the meaning of the words 
this time. 
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Favorite Characters Graph – Day 1 - page 9 
 

Trainer Notes for Character Favorites Graph 
1. Introduce this activity by asking teachers what are some of the learning 

objectives that they focus on. They will name all kinds of things. If they don’t 
bring up counting and graphing, tell them that in this next activity you are going 
to focus on math.  

2. Have someone read the essential question and learning goals for this activity then 
go right into the activity. 

 
 

Trainer: End of Activity Discussion Character Favorites Graph 
1. Before closing the graph you made go over the printing options including the large 

size graph printouts. 
2. Show participants some of the other areas of the program such as matching 

section, which reinforces counting, and 1-to1 correspondence. 
3. Ask people to share some the things that they graph in their room. 
4. Tell people that if they have one computer in their room they may want to have 

pairs of students graphing as a center activity and show them the management 
tool for tracking student’s work. 

5. Talk about how to have students save in a way that it makes it easy to check. 
Emphasize that teaching students to use a naming convention such always 
including student initials in the file name, makes their life easier because you 
don’t have to open the file to see who it belongs to. 

6. Finally mention that when students bring data sheets or storyboards to the 
computer with them, it makes better use of their time. 

7. Tell them that the essential question for this activity were “Can I effectively use 
one computer as an instructional tool in my classroom? Can I create graphs using 
Graph Club?” Point out that the teacher taught a lesson with the piece of 
software first so that students could see how to use it. 
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 Favorite Character Graph 
 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I effectively use one computer as an instructional tool 
in my classroom? Can I create graphs using Graph Club? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question: 
Which is our favorite book character this week? 
 
Learning Goals: 

• Students will listen and participate in the activity. 
• Students will vote for their favorite book character 

for this week. 
• Students will count accurately and record 

information on the graph. 
 
Prior Knowledge 
Students need to have had some knowledge of graphing. 
 
Materials: 
Data Collection Sheet, 
Copies of each book read so far that week 
Stuffed animals or pictures of story characters 
 
Technology Connections: 
Students will view build a graph whole group and then 
collect data to create a graph independently using Graph 
Club. 
 
Preparation: 
Have a large sheet of craft paper so that students can 
make a floor graph.  
Have either puppets or pictures of Max and a Wild Thing 
in a bag. 
Draw a picture of the data collection sheet leaving off the 
character's names. 
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Favorite Characters Graph – Day 1 - page 10 
 

NOTES 
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Whole group 
instruction 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Graph Club 

 
Procedures: 

1. Organize the students so that they can see the 
computer. Have the puppets or pictures of the story 
characters in a bag. Begin the activity by asking 
them what the word “favorite” means? 

2. If they are not sure, talk about it until they come to 
an understanding that a favorite is something a 
person really likes.  

3. Then tell students that today we are going to be 
recording some favorites using a graph. Ask them if 
they know what a graph is.  If they do not, tell them 
that a graph is a way to show numbers that make it 
easy to read and compare numbers. 

4. Open the bag and bring out the first story 
character (Max). The students should easily identify 
this character and be able to tell you some things 
about it. Have them describe what makes this 
character interesting and unique. Repeat this 
activity with the other 1-2 additional characters.  
(Wild Things) Set the characters on the bottom of 
the floor graph. 

5. Tell the students that you want to know which of 
those characters is their favorite. Have students 
get up and sit behind their favorite character facing 
you. When everyone has voted, write the number of 
students that chose the character below the name/ 
picture of the characters. Open Graph Club and click 
on Create a Graph. Take the data that was collected 
and create a graph showing students how to turn the 
pictures into words, how to add numbers into the 
columns, how to add a title, and labels to the graph. 

6. Read the graph and check it against the data 
collection sheet. Ask the students if they can tell 
which character was their favorite this week and 
which character was not liked as much this week? 

7. The next day tell students that they are going to 
work together to gather data about favorites and 
then create a graph. 

8. Put the students into pairs. Give each child a data 



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                  Trainers Manual  
 

Copyright  2004  i3 Training Services  Inc. 

Favorite Characters Graph – Day 1 - page 11 
 

NOTES 
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Paired 
computer usage 
 
 

collection sheet and tell them that first they need 
to agree which two items they want to find out 
about. Give examples in the form of a question: 
Do you like Arthur or Little Bear better? 

9. Put the students into pairs. For five minutes, have 
the partner groups determine which book 
characters they want to ask about. Tell them that 
when they come back to meeting they need to have 
their names on their paper and the name or picture 
of a character in each box. Circulate among the kids 
helping them complete this task. Using the initials of 
the characters or having the students draw pictures 
of the characters instead of the name are a couple 
of ways to solve the writing issue. 

10. Have pairs of students come up to pose their 
question and using the floor graph have the rest of 
the class move and sit in the correct column to vote 
their choices.  

11. In a one-computer classroom, the next step would 
be to have a pair of students come up and create 
their graph using Graph Club while the other 
students are watching. Describe what the students 
are doing as they complete the graph for the rest 
of the class. 

12. Staple the papers for each pair together and put in 
a folder near the computer so that when pair is done 
they can pull the next pair’s papers and get them to 
do the activity. If a lab setting is available, then 
pairs of students can work on this all at once. 

13. When students have completed their graph, have 
them print 2 copies, write their name on them, and 
turn those copies and their data sheets in together. 

14. Review their graph for accuracy based on their data 
collection sheet. Teachers also may want to take the 
time to have students talk about the graph. 
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Trainer Notes for Favorite Character Graph Data Sheet 
 
Put the students into pairs. For five minutes, have the partner groups determine which 
book characters they want to ask about. Tell them that when they come back to meeting 
they need to have their names on their paper and the name or picture of a character in 
each box. Circulate among the kids helping them complete this task. Using the initials of 
the characters or having the students draw pictures of the characters instead of the 
name are a couple of ways to solve the writing issue. 
 
Have pairs of students come up to pose their question and using the floor graph have 
the rest of the class move and sit in the correct column to vote their choices.  
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Favorite Character Data Collection Sheet 
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Software Helper 
Graph Club  

 

The Graph Club is a versatile school graphing tool. The Graph Club begins with a short 
introduction featuring Fizz and Martina.  Following the introduction (which you have the 
option of skipping) you come to The Graph Club’s main menu. This menu lets you select 
one of The Graph Club’s four modes, each of which emphasizes a different set of 
graphing skills. Simply click one of the boxes and you will find yourself ready to start 
graphing. 

 
Explore Mode 
Explore mode allows you to create graphs. When you enter Explore mode, a pair of blank 
graphs automatically appears on your screen -- one picture graph and one bar graph. 
When you add or delete data in one of the graphs, the other graph changes 
automatically, allowing you to view the same data side by side in different formats. 
 
Enter and Delete Data 
Click an icon (from the row of icons at the top of the graph), hold the mouse button 
down, and drag the icon into the graph. Watch for the bar to appear over the icon at 
the bottom.  When the column is highlighted, release the mouse. One unit will be added 
to your graph. You can delete an entry by clicking on it when the X appears. 
 
Change Axis Labels, Icon Labels, or Table Title:  To change axis labels, go to your bar 
graph and click "What" (above the Graph Type buttons). Enter a label for the X axis. Do 
the same for the Y axis by clicking "How Many." 

 
To add or change icon labels, click the little icons along the X-axis and enter a label for 
each one. (Each item in your graph can be labeled with either an icon or text.) 
 
Graph Menu: 

Graph Kinds: This option lets you choose how many kinds of objects you will be 
graphing.   
 
Choose Scale Maximum: This does the same thing as clicking on the words each=1 
in the upper left-hand corner of the graph.  You can choose what value each 
picture has in your graph. 
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Choose Symbols: Click and drag on the symbol that you wish to use to replace 
those currently on the graph. Design Your Own Icons.  You can import your own 
graphics to use as icons. Copy the graphic you want into the Clipboard.  Open The 
Graph Club.  Choose 'Choose Symbols' from the Graph menu.  Click Paste from 
Clipboard. The cursor will change to your icon. Now just click the icon bin where 
you wish to place your icon! 
 

Options Menu: 
Graph Vertically, Graph Horizontally: This allows you to change the orientation 
of your graphs on the screen. 
 
Show bar and line grid: This enables you to show or hide the grid. 
 
Show axis labels: This enables you to show or hide the axis labels. 

 
Special Menu 
Edit Groups: Add and edit classes for use with the Random Student Picker™. The 
Random Student Picker lets you randomly select a student to enter data, answer a 
question, interpret a graph, or offer his or her opinion. It is a fun way to involve the 
entire class and keep students on their toes! 

 
Here is how to enter and edit data for a class or group: 
 
1.  Choose Edit Groups from the Special menu. Then click New Group and enter a 
name for your class. 
 
2.  Click New Student and enter the name of a student in the class. You can enter 
as many names as you want. 
 
3.  To edit a class list, select the name of the group in the Groups box on the left. 
You will then see a class list in the box on the right. You can now add or remove 
students from the list. To remove a student, just select the appropriate name and 
click Remove Student. 
4.  To remove a group, select the name of the group in the Groups box and click 
Remove Group. 
 
5.  To determine which group the Random Student Picker will use, select that 
group from the Groups box, click Close Group Editor, and Keep Any Changes. Now 
you are ready to pick a student! 
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Pick Student: Activates the Random Student Picker. If you have more than one group 
set up, you’ll need to choose Edit Groups and select the group you want the program to 
pick from before you choose Pick Student. To leave the Random Student Picker, just 
click the graphic. 

 
Print Special Setup: Select custom options for printing the special graphics that come 
with The Graph Club (including Match Certificates).  Blank Match Certificates, for 
example, should be printed landscape rather than portrait.  

 
Print Special: Choosing Print Special from the Special menu lets you print special 
graphics.  The lesson pictures are from a special Graph Club Curriculum Kit that can be 
ordered separately. 

 
Teacher Options:  Choosing Teacher Options from the Special menu lets you customize 
preferences to meet the needs of your students. This option is always grayed (to 
restrict access). To select Teacher Options hold down the Shift and Control keys and, 
without letting go, pull down the Special menu and choose Teacher Options. (Note: If 
you pull down the Special menu before pressing Shift and Control, Teacher Options will 
remain grayed.) 

 
The Teacher Options menu allows you to set the following preferences: 
 

General Options 
Checking the first option lets you allow multiple graph sets to be opened.  
 
Checking the second option lets you disable line graph buttons when more than 
one symbol is chosen. (Line graphs chart changes of one thing over time. A line 
graph with multiple symbols could be confusing.) 
 

Allow Students to Use 
This option lets you restrict the types of graphs (table, picture, bar, line, circle) 
students can use.  
 

Match Activity Settings 
These settings allow you to control a number of Match mode features. You can: 
• Select the graph type for the randomly generated graph (the "from" 

graph). This one appears on the left of your screen. 
• Select the graph type students will create (the "to" graph).  
• Determine how many kinds of things will be graphed (from 1 to  
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• Restrict students from changing the type of graph they match "from" and 
"to" (by graying the Graph Type buttons in Match mode graphs). 

 
Sound Preferences 
These options allow you to turn various program sounds on and off. 
 
Match mode generates a random graph and challenges students to create a different 
type of graph that represents the same data. Match mode gives students hands-on 
experience reading graphs and lets them see the transformation of data from one form 
to another.  

 
After opening a new file in Match mode:   

• Complete the Match challenge; then click Check My Match!  
 

• If the program finds an incorrect match, it tells you, "Now match the 
others!"  The Graph Club gives students as many tries as they need to match 
the graph  correctly. 

 
• If all matches are correct, a graphic will appear saying, "Great Job! You 
 Matched It!"  Click this graphic to make it disappear. 

 
• After successfully completing a match, click Print Certificate. This is a 
great  way to reward students’ success with graphing. Click Next Match to try 
 another matching challenge! 

 
Cool Feature: Using Teacher Options... in the Special menu, you can change the 
Match mode graph types and control a number of other Match mode features. 

 
Create Mode 
This mode addresses the cognitive challenge of transforming data from numeric to 
graphic form. Create mode automatically brings up a table with each data value set to 
zero. Students can then collect a set of data, enter it into the table in numeric form, 
and explore how those numbers are transformed as views of other graph types (picture, 
bar, line, or circle) are created.  
 

After opening a new file in Create mode: 
• Click each zero and enter data for your table. The default scale maximum is 
 10, a setting you can change by choosing Choose Scale Maximum... from the 
 Graph menu. 

 



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                  Trainers Manual  
 

Copyright  2004  i3 Training Services  Inc. 

Graph Club Software Helper – Day 1 - page 17 
 

NOTES 



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                                       Day 1 
 

Copyright © 2004 i3 Training Services Inc.                       inspiring, innovative, integration      17 

• Once you have entered data for each item, go to the Graph menu and 
choose Make Another Graph. This allows you to see your data represented in 
 different forms. (As you open additional graphs, you may need to resize 
them  to see them all at once.) 

 
Guess Mode 
Guess mode is designed to build critical-thinking and graph-reading skills, and help 
students understand that there are often many good answers to a question. This 
brainstorming activity also develops an awareness of the many different types of data 
that can be represented in graph form. 
 
Guess mode randomly generates graphs and challenges students to hypothesize about 
what the data might represent, why someone would have made that particular graph, and 
what people could conclude from the graph. (While the data is generated randomly, you 
can change the icons to graph any type of information you choose.)   
 
Cool Activity: Using New in the File menu, open several Guess graphs at once (each will 
have the same symbols, but different data). As each graph is generated, ask students to 
compare the data. Challenge them to explain what underlying differences the graphs 
could be representing. 
 
Cool Feature: Change the icons in the graph for a variety of critical thinking challenges. 

Suggested Activities 

Favorite ice cream flavors:  chocolate, vanilla, strawberry, mint 

Pets:  dog, cat, rabbit, fish, bird 

Favorite fruit:  apple, orange, strawberry, cherry, lemon, lime, banana, pear, pineapple 

Favorite Holiday:  Fourth of July, Thanksgiving, Christmas, Hannakah,  Halloween, 
Easter 

Favorite Season:  Spring (flower), Summer (sun), Fall (leaf), Winter (snowflake) 

Weather:  Sunny, Partly Cloudy, Rainy, Thunderstorm, Snow 

Favorite Sport:  Soccer, Basketball, Football, Skating, Baseball 
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Trainer Notes for Learning Letters 
1. When students come back together tell them that in the morning they four 

different pieces of software and that the software was used to instruct and was 
used by students both in pairs and individually.  

2. Tell them that this afternoon we are going to continue looking at ways educational 
software can help address curriculum objectives but to do that we first need to 
go get the next piece of software they are going to use. 

3. Have students download the software and install it on their computer. Directions 
are on page 23. 

4. Begin the activity by asking teachers in what way they teach the students the 
letter of the alphabet and then go into the lesson. 
Heads up- if the network is busy downloading may take a while. Be prepared to 
start the download process, go on to the Brown Bear Activity and then come back 
to this activity. 

 
Trainer: End of Activity Discussion Learning Letters 

1. Talk with the teachers about how this is a portion of a larger piece of software. 
Show them how to get more information on it from the Riverdeep Site. 

2. Talk about evaluating software to determine whether or not it meets the 
educational goals of the program and whether it is strong to be used for a period 
of time. May want to show them sites for software evaluation. Page 41 in their 
book addresses this. 
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Learning Letters 
 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I effectively use one computer as an instructional tool in 
my classroom? Can I teach letter identification using a free 
downloadable resource? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
http://www.riv
erdeep.com/pr
oducts/downlo
ads/free_dow
nloads.jhtml 
 
Additional 
Cihicka Chika 
Boom Boom 
Resources 
http://www.at
ozteacherstuf
f.com/lessons/
ChickaChicka.s
html 
 

Instruction 
Essential Question for the Lesson: 
Can students identify the letters the alphabet? 
 
Learning Goal(s): 
Students will identify the upper and/or lowercase letters. 
 
Technology Connection: 
One Internet connected computer 
Downloadable program Letter Machine from Riverdeep 
 
Materials: 
A copy of Chicka Chicka Boom Boom 
Laminated alphabet letter cards 
1 copy of the of activity sheet per child 
 
Procedures: 

1. Download and install the Letter Machine program from 
Riverdeep on all of the computers you will be using. See 
Quick Tip Sheet for directions. Make sure that the 
computers have sound and are adjusted to the right 
level or that ear phones are available. 
Create a big coconut tree with upper and/or lower case 
letters on it all mixed up. Before you introduce the 
activity, hang the tree where it will easily be seen. 
Make alphabet letter cards and laminate them. 
Prepare the computer by connecting it to a television or 
a projector. 

2. Have the students come and sit where they can see the 
chart and also see the computer. Cover the chart so 
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Individual or 
Pair 
 
 
 

 
http://www.dl
tk-
kids.com/book
s/chicka/ 
 
 
 
 
 
 
 
 
 
 
 

that it is not immediately visible. 
3. Tell the students that you have a story for them today.  

Show them the cover and read the book.  Discuss what 
happened in the story. The students should tell you 
that the story is about letters climbing a tree and 
falling out. 

4. Hand out the letter cards to the students and read the 
story a second time having them come up and place the 
cards on the coconut tree and take the letters back 
off the tree. Retrieve all the letters and put them 
away. 

5. Now tell students that you have a letter game for them 
to play. Turn on the monitor and introduce Letter 
Machine. Show the students how to start the game and 
then have them in pairs rotate through the game as a 
center. Each member of the pair should complete a 
different activity sheet. Emphasize to the students 
that the drawings should be quick pencil sketches not 
fully rendered pictures. 

6. This activity can be done more than once by changing 
the letters in the activity sheet or focusing on the 
ends of words rather than the beginnings of words. Use 
the assessment provided to see how students are doing 
with identifying letters. Teachers may want to laminate 
the assessment and have students use wipe off 
markers on the laminated copy. In this case record 
their results on a separate piece of paper. 
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Trainer Notes for Letter Machine 
 
Tell teachers that you have a letter game for them to play. Turn on the 
monitor/projector and introduce Letter Machine. Show the students how to start the 
game and pick a letter that the whole class will do together. Have them sketch the 
images that go with the letter. Then group teachers in pairs and explain how they could 
rotate their through the game as a center or using several machines in a lab. . Each 
member of the pair should complete a different activity sheet. Emphasize to the 
students that the drawings should be quick pencil sketches not fully rendered pictures.  
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Letter Machine Activity 
 
Name__________________________ 
 
Draw a picture of the animal that goes with each letter. 
 

     Letter          Picture 

f  
g  
k  
r  
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Letter Machine Activity 
 
Name__________________________ 
 
Draw a picture of the animal that goes with each letter. 
 

     Letter          Picture 

b  
h  
t  
p  
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Pass out the laminated assessment sheets. Give students a marker and tissue. Conduct a 
whole group letter recognition assessment. 
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Letter ID Assessment 
 
Name ________________________  Date____________ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
C   M   T   R 

 
A   P   L   G 

 
K   D   O   N 

 
E   B   W           U 

 
I   J   Q   Y 

 
S   V   H   X 

 
    Z   F 
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 Downloading &  
Installing Programs 

 
1. Type in the address or URL of the program you want to download into your 

browser’s address window. Press the Enter or Return key on your keyboard and 
wait for the web site to load. 

2. Read the information provided on the site to make sure that you choose the 
version of the program that is right for your computer. That usually involves 
choosing MAC or PC. If you are using PC, check to make sure whether the 
program will work on Win 95/98, Win 2,000, Windows ME, or Windows XP. 

3. Click the correct version and you will be prompted as to whether you want to 
open the program or save it. Choose to save the program and then choose where 
you want to save it. If you have the option, save it to the desktop so that it will 
be easy to locate. Look at the name of the program so it will be easy to locate. 

 

 
 

4. Depending on your connection it may take a few minutes for the program to 
download. When it is finished, close your Internet connection and any other 
open files on your computer.  Locate the program. 

5. Double click to install the program and follow the directions. Usually an 
installation wizard walks you through the process of actually installing the 
program. 

6. You may have to restart the computer before using the program. Test to make 
sure it is working prior to using it with students. 
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Brown Bear, What do you see? – Day 1 - page 24 
 

Trainer Notes for Brown Bear, Brown Bear What Do You See? 
1. Introduce this activity by telling participants that templates are one way to 

facilitate students’ work and sense of achievement. Tell them that the focus of 
the activity is on writing their own name, learning their friends’ names and 
drawing.  

2. Organize the students so that they can see the computer and are sitting in a 
circle. Make copies of the prep sheet for the slide show for each student. 

3. Introduce the story Brown Bear, Brown Bear. Ask students if they have heard it 
before. 

4. Tell them that today when they hear it you want them to listen to the pattern in 
the story. Read the story slowly encouraging the students to chime in when they 
understand the pattern. 

5. When you are through reading the story, have the students articulate the 
pattern in the story. Tell the students that they are going to make a new story 
that will be similar to Brown Bear, but instead of the animals being the stars of 
the story that they are going to stars in the story. Begin the new story by using 
their names in place of the animals. Tell the students that they always say the 
name of the person next to them as they go around the circle. Explain to the 
children that because we are talking about people we will use the word "who" 
instead of "what" in the story. 

a. Example: Madeline, Madeline who do you see? I see Griffin looking at me. 
6. Now tell the students that they are going to create a slide with their names for 

this story. Turn on the monitor and open up the template for the brown bear 
story. Demonstrate what the students will do by filling    in the template with 
your name and the name of the student sitting next to you. Have students on the 
bottom of the template create a picture of their face. 

7. Finally demonstrate how to save the picture and tell the students how they should 
get the next student to do their slide.  

8. Hand out the prep sheet and go over it with the students. Have the students 
write their name. Have the person sitting next to them write their name in  the 
blank provided so that students are  ready when they get to the computer. 

9. Have students either one at a time or in pairs create their slide in Kid Pix and 
save it.  When they are done, pull all the slides into a slide show and share the 
new story with the class. Have them join in as you read the story. 
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Brown Bear, Brown Bear What Do You See? 
 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I create a reading resource for my students? Can I use 
a software program to teach students to recognize names? 
Can I create a slideshow using Kid Pix? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Essential Question: 
Can I recognize patterns in stories? 
Can I learn the names of my friends? 
 
Learning Goals: 
Students will identify the pattern in the story. 
Students will create a new version of this story with their 
names. 
Students will type their name and the name of a friend into 
a template. 
 
Materials: 
1-3 computers with Kid Pix software 
 
Preparation: 
Make sure that Kid Pix is installed on all of the computers 
you will be using. 
Determine where you need to save the student’s files so 
that they all can be pulled into a slideshow. 
Make copies of the prep sheet for each student. 
 
Procedure: 

1. Organize the students so that they can see the 
computer and are sitting in a circle. Make copies of 
the prep sheet for the slide show for each student. 

2. Introduce the story Brown Bear, Brown Bear. Ask 
students if they have heard it before. 

3. Tell them that today when they hear it you want them 
to listen to the pattern in the story. Read the story 
slowly encouraging the students to chime in when they 
understand the pattern. 
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Trainer: End of Activity Discussion Brown Bear, Brown Bear  
What Do You See? 

1. Stress to people that for any presentation program they are using it is good 
practice to keep all the files in one folder. Tell them the most common mistake 
teachers make is trying to do a presentation when their files aren’t in the same 
place.  

2. Explain the Kid Pix is a DOS program and only takes short names of under 8 
characters with no punctuation or spaces when saving. Show them how to navigate 
in Kid Pix to save the picture into their own folder.  

3. Briefly show participants how some basic file management. Have them copy and 
paste their slide into the group folder on the shared drive. Then throw all slides 
into the slideshow and run it.  

4. Make sure to point out in their manual the quick tips sheets. 
5. Refer the participants to the Reference Section for more information on file 

management. It is in Section 3 page 27. 
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Individual 

4. When you are through reading the story, have the 
students articulate the pattern in the story. Tell the 
students that they are going to make a new story that 
will be similar to Brown Bear, but instead of the 
animals being the stars of the story that they are 
going to stars in the story. Begin the new story by 
using their names in place of the animals. Tell the 
students that they always say the name of the person 
next to them as they go around the circle. Explain to 
the children that because we are talking about people 
we will use the word "who" instead of "what" in the 
story. 

      Example: 
Madeline, Madeline who do you see? 
I see Griffin looking at me. 

5. Now tell the students that they are going to create a 
slide with their names for this story. Turn on the 
monitor and open up the template for the brown bear 
story. Demonstrate what the students will do by 
filling    in the template with your name and the name 
of the student sitting next to you. Have students on 
the bottom of the template create a picture of their 
face. 

6. Finally demonstrate how to save the picture and tell 
the students how they should get the next student to 
do their slide.  

7.  Hand out the prep sheet and go over it with the 
students. Have the students write their name. Have 
the person sitting next to them write their name in     

  the blank provided so that students are  ready when 
they get to the computer. 

8. Have students either one at a time or in pairs 
create their slide in Kid Pix and save it.  When they 
are done, pull all the slides into a slide show and share 
the new story with the class. Have them join in as you 
read the story. 
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Trainer Notes for Brown Bear Prep Sheet 
Hand out the prep sheet and go over it with the students. Have the students write their 
name. Have the person sitting next to them write their name in the blank provided so 
that students are ready when they get to the computer. 
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Brown Bear Prep Sheet 
 
Name___________________________________ 
 
 
 

_____________ ______________who do you 
see? 
 

I see _________________ looking at me.  
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Slideshow Quick Tips 
Kid Pix Studio Deluxe Steps 

 
Getting Started: 
1.  Have a blank floppy disk prepared on which to save slides. 
 
2.  Open Kid Pix Studio Deluxe.  From the Picker menu, choose Kid Pix. 
  
To Create a Title Slide: 
 
1.  Add a background: 

• Click the Paint Bucket Tool.  Select a color from the Color Palette.  Select a 
pattern from the Options Tray.   Move the Paint Bucket onto the page and 
click. 

 
2. Add a title: 

• Click the Typewriter Tool.  Select a font, size, and style from the Options 
Tray.  Scroll to choose a font or double-click the font window to choose a font 
from a list.  Select a color from the Color Palette.  Click to plant the cursor on 
the screen.  Begin typing.   

 
3.   Editable text is a new feature available in Kid Pix Studio Deluxe.  Text boxes float 

above the background, making them easy to edit and move.  Simply click the 
Typewriter Tool and then click to select a text box.  You may now change the font, 
size, color, etc. or move the text box by clicking and dragging.  To edit text, click to 
plant the cursor.  Then backspace over text to remove letters or words.  Type to add 
text.  It’s that easy!   

 
4. If you are NOT using the Deluxe version of Kid Pix Studio, you do NOT have editable 

text boxes.  Follow the steps below to center the title. 
 

5.  Center the title: 
• Click the Moving Van Tool.  Click the Magnet in the Options Tray.  Your cursor 

will become a +.  Move the + to the upper left portion of the title.  Click, hold, 
and drag to select the title.  You will see marching ants around the title.  Click 
in the middle of the title (you will see the magnet), hold and drag the title 
until it appears centered.  Follow the same procedure to center any other 
text.   



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                  Trainers Manual  
 

Copyright  2004  i3 Training Services  Inc. 

Kid Pix Software Helper – Day 1 - page 28 
 

NOTES 



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                                       Day 1 
 

Copyright © 2004 i3 Training Services Inc.                       inspiring, innovative, integration      28 

 
6.  Fill in white spaces: 

• Click the Eyedropper Tool.  Move the Eyedropper onto the background and 
click.  This tool picks up the exact color of the background.  Now click the 
Paint Bucket.  Move the Paint Bucket to white areas and click to fill with 
background color. 

 
7.  Add a second row of text:  By _________ 

• Click to plant the cursor in the desired location on the screen.  Choose a font, 
size, color, and style.  Begin typing. 

 
8.  Resize text boxes: 

• Click one of the red handlebars on the text box.  Click, hold, and drag to 
resize. 

 
9. Hear text read aloud: 

• Under the Speech Menu, choose Read Text Aloud.  (This feature will not work 
if text is painted to the background.) 

 
• If a word is mispronounced, you may edit the speech by choosing How to 

pronounce from the Speech Menu. 
 
10.  Paint text to background: 

• Text boxes float above the background.  You may choose to affix the text 
boxes to the background.  Click the Typewriter Tool.  Under the Toolbox 
Menu, choose Paint Text to Background.  You may paint only the active text 
box, or all text boxes to the background.  When you paint the text to the 
background, it may no longer be edited!!  In addition, if text is painted onto 
the background, it may not be read aloud! 

 
11.  Record a sound: 

• Under the Goodies Menu, choose Record a Sound.  Click the Record Button.  
Record your text for the title slide.  Click the Stop Button.  Click the Play 
Button to preview the recording.  Click Save. 

 
12.  Decorate the title page: 

• Click the Rubber Stamp Tool.  Under the Goodies menu, pull down to Pick a 
Stamp Set.  Scroll down until you see the Nature stamp set.  Click to choose 
the Nature stamp set.  Click OK. 
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• Scroll through the Options Tray to find stamps of ocean animals.  Click to 
select the stamp you wish to use.  Your cursor will become the stamp.  Move 
the stamp onto the page in the desired location.  Click to place stamp.   

 
13.  Enlarge stamps: 

• Press the Control key to make the stamp one size larger.  While the Control 
key is pressed down, click to stamp. 

• Press Control and Shift to make the stamp even larger.  Click to stamp while 
holding down Control and Shift. 

 
14.  Edit a stamp: 

• Click to select the stamp you wish to edit.  Under the Toolbox menu, click Edit 
A Stamp.  You may flip the stamp, draw on it, paint it a different color, etc.  
When you are finished editing, click OK.  Click to stamp.  When you are 
finished with that stamp, go back to Edit A Stamp under the Toolbox menu.  
Click Restore Original to restore the stamp to its original position and color.  
Click OK.  You may also double-click the stamp in the Options Tray to access 
the stamp editor. 

 
15.  Save slide 1: 

• Select Save a Picture under the File menu.  Choose a location in which to save.  
(floppy disk - A drive)  Name your picture (slide1).  Select Save Sound.  Click 
OK. 

 
To Create New Slides: 
1.  Add a new page: 

• Choose New from the File menu. 
 

2.  Add a background:   
• Click the Paint Bucket Tool.  Select a color from the Color Palette.  Select a 

pattern from the Options Tray.   Move the Paint Bucket onto the page and 
click. 

 
3.  Draw a picture: 

• Use the Pencil Tool to draw a picture on the page.  Notice you have two Option 
Trays - one has a blunt pencil point, one has a rounded pencil point. Make sure 
all lines are connected.  Fill your picture using the Paint Bucket. 

 
4.  Erase: 

• Use the Eraser Tool’s first four options to erase small mistakes.   
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• The remaining options in the Options Tray will erase the entire page.   
 

5.  Undo: 
• Click the Undo Man to undo your last operation if you make a big mistake.   
 

6.  Add text:   
• Click the Typewriter Tool.  Select a font, size, and style from the Options 

Tray.  Scroll to choose a font or double-click the font window to choose a font 
from a list.  Select a color from the Color Palette.  Click to plant the cursor on 
the screen.  Begin typing.   

 
7.  Record a sound: 

• Under the Goodies Menu, choose Record Sound.  Click the Record Button.  
Record your text for the title slide.  Click the Stop Button.  Click the Play 
Button to preview the recording.  Click Save. 

 
8.  Save slide : 

• Select Save a Picture under the File menu.  Choose a location in which to save.  
(floppy disk - A drive)  Name your picture (slide2).  Select Save Sound.  Click 
OK. 

 
To insert a graphic from an outside source: 

• From the File Menu, choose Import a Graphic. 
• Find a graphic that you wish to use.   
• You will see a preview of the graphic on the left side of the Import a Graphic 

window.  You may rotate the graphic by clicking the rotate arrows below the 
graphic preview. 

• Choose to position the graphic on the drawing area by selecting one of the 
following options: 
 Fill Screen will make the graphic fill the entire drawing area   
 (picture may get distorted). 
 Scale to Fit will make the graphic fit the drawing area    
 proportionally. 
 Center will place the graphic in the middle of the drawing area.      

                    It will appear in its original size. 
 Upper Left will place the graphic in the upper left corner of the  
 drawing area.  The graphic will appear in its original size. 
 Scale Manually will enable you to move and resize the graphic by  
 hand. 
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* Scale manually is an option available only in Kid Pix Studio Deluxe. 
 
• Choose Scale Manually.  Click OK. 
• Move the graphic by clicking, holding, and dragging from the center of the 

graphic.   
• Resize the graphic by clicking, holding, and dragging from one of the blue 

handlebars.  Drag inward to reduce the size of the graphic.  Drag outward to 
increase the size of the graphic. 

• Position the graphic.  Click outside the graphic area to place graphic on page. 
 
3.  Select a background color: 

• Choose the Eyedropper Tool.   Click a desired color on the graphic to choose a 
background color.  This places the desired color on the Color Palette. 

 
4.  Add a background: 

• Choose the Paint Bucket Tool.  Your selected color should be on the Color 
Palette.  Click to paint the background. 

• Some graphics may have a white border around them.  If this is the case, you 
may use the Paint Bucket Tool to fill in the white border.  Occasionally, paint 
will bleed into your graphic.   You may choose to frame the graphic.  Choose 
the Rectangle Tool, and the Transparent Option in the Options Tray.  
(Transparent Option is the third one from the left.)  Click, hold, and drag to 
draw a rectangle around the graphic.   

 
5.  Add text:   

• Click the Typewriter Tool.  Select a font, size, and style from the Options 
Tray.  Scroll to choose a font or double-click the font window to choose a font 
from a list.  Select a color from the Color Palette.  Click to plant the cursor on 
the screen.  Begin typing.   

 
6.  Record a sound: 

• Under the Goodies Menu, choose Record a Sound.  Click the Record Button.  
Record your text for the title slide.  Click the Stop Button.  Click the Play 
Button to preview the recording.  Click Save. 

 
7.  Save slide: 

• Select Save a Picture under the File menu.  Choose a location in which to save.  
(floppy disk - A drive)  Name your picture (slide3).  Select Save Sound.  Click 
OK. 
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• Select Save a Picture under the File menu.  Choose a location in which to save.  
(floppy disk - A drive)  Name your picture (slide4).  Select Save Sound. Click 
OK. 

 
To pull slides into a slideshow: 
 
1.  Insert the slides 

• Under the File menu, choose Return to Picker. 
• Click Slideshow. 
• In the first moving van, click the picture button (lower left, beside the music 

note).   
• Insert slide one. By navigating to the disk or folder where the slides are 

located, clicking on the slide and then clicking OK. 
• Continue until slides have been added to the slideshow. 

 
2.  Choose or add sound: 

• Click the music button on the first moving van.  
• Choose a sound.   

The black box contains Kid Pix sounds. 
The abc option selects the computer voice to read story to you.   
 (Available only in Kid Pix Studio Deluxe.)  
The Kid Pix option selects a sound you recorded while in Kid Pix. 
The microphone option enables you to record a sound now. You have 16 seconds 
for a recorded sound. You may choose More Sounds to access.wav files and 
import a sound. You may choose no sound. 

• Click Select. 
• Follow the above steps to add sound to remaining slides. 
 

3.  Add transition: 
• Click the transition button to the right of the music note.   
• Click to select a transition. 
• Click preview to view the transition. 
• Click Select. 
• Follow the above steps to add transitions to remaining slides. 

 
4.  Add a second sound to the ending slide: 

• On slide four, record a sound “The End.” 
• Choose a scissors transition. 
• For the fifth moving van, import slide four again.   
• Choose a different sound for this slide - hands clapping, for example. 
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• When the slide show plays, you will hear “The End” followed by applause. 
 

5.  View or change time for each slide: 
• Click and hold the gray button on the time slide bar to view the current time 

elapsed for that slide.  The time slide bar is below the truck.  Click the gray 
button to the right of the yellow mark. 

• Click and drag the gray button to increase or decrease the time for each slide.  
Slide will play for at least the length of the time the sound plays, with a 
maximum of 30 seconds per slide. 

 
 
6.  Rearrange slides: 

• Click and drag the moving van to the desired location to rearrange slides. 
 

7.  Delete a slide: 
• Click to select the slide you wish to delete.   
• Click the dynamite. 
 

8.  Undo your last operation: 
• Click the undo man immediately. 
 

9.  View slide show: 
• Click the triangle button at the bottom of the screen to view the slide show 

once.  
• Click the boxed triangle to play the slide show looped.  Double click to stop the 

looped slide show. 
 

10.  Save slide show: 
• File menu - Save a Slide Show - make sure Kid Pix pictures (.bmp files) and 

slide show are saved in the same location.  You will need Kid Pix Studio 
software to run this slide show.  This saving option enables you to edit the 
slide show. 

• File menu - Save an AVI - saves your slide show as a movie file, which may be 
viewed in Wacky TV. 

• File menu - Save a Standalone - saves your slide show by itself.  It saves the 
slide show as an executable file, with a .exe extension.  It will run without Kid 
Pix Studio software; however, you will not be able to edit. 
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At this point in the day assess how the participants are doing. You may want to save the 
Anansi activity for the morning if they are tired, cranky or glazed over. It is better to 
omit one activity then rush through it and not leave time for email or brain check. 
 

Trainer Notes for Two Anansi Tales 
1. Create a Venn diagram and save it as a template before the activity begins.  
2. As teachers how many can afford to have a professional storyteller come into 

their room on a regular basis? This should get some laughs.  
3. Then tell them that in this activity they are going to invite a professional 

storyteller into their room through the Internet. Before opening up the link ask 
them if they know of Anansi or Kwaku Anansi as he is sometimes called. If they 
don’t, then briefly describe the character. Then begin the activity. 

4. Have students come, sit and be ready to participate. Introduce the activity by 
telling students that they are going to watch two stories today and you want them 
to pay careful attention and be ready to talk about the stories. 

5. Open the first story “Anansi and the Two Feasts” and play the first story.  
6. Bring up the Venn Diagram. Tell the students that they just heard the first story 

and that you want them to think about the story and help to describe it. 
Introduce the Venn Diagram and type the word title of the story over one circle. 
Show them where the two circles overlap and explain to them that some things 
about the stories are different and some are the same. Tell the students that 
the parts that are different we will write in the part of the circle that is not 
overlapped. If the two stories have something in common we will put that in the 
area where the circles overlap. 

7. Open the second story which is “Anansi and the Shaking Hat Dance” and play it. 
Again talk with the students about what makes them feel scared. 

8. Bring the Venn diagram back up and then type the title of the second story over 
the second circle. Add 1-2 word descriptors of the items the students mention 
into the second circle. When the students bring up something that the stories 
have in common and make sure to put it in the right place.  

9. To finish the activity today review the Venn Diagram and read the words the 
students contributed. Quiz the students to see if they can read the words with 
you. Then tell the students that they are to choose a word and create a picture 
of something that makes them feel that way.  

10. On day 2 begin the lesson by asking the students which stories they read 
yesterday.  
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Two Anansi Tales 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I use a word processing program to create a Venn 
Diagram? Can I use Kidspiration to respond to student 
literature? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Teaching with 
one computer 
and a 
projection 
device to 
explore 
literature 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Electronic 
literature 
from the 
Internet 
 
 
http://www.
bookhive.org
/zingertales
/default.asp
?storyid=16 
 

Essential Questions: 
Can students listen and respond to digital literature? 
Can students use a children’s program to respond to 
literature? 
 
Learning Goals: 
Students will listen and read electronic literature. 
Students will participate in discussion about the story.  
Students respond to the story. 
Student will create and describe an original character. 
 
Prior Knowledge: 
Students need to be familiar with Anansi 
 
Technology Connections: 
One computer with Internet connectivity 
Kidspiration 
MS Word 
 
Preparation: 
Make sure that both stories work on the computer you will 
be using them on and that the Real Player  Plug-in is 
loaded. 
 
Procedures: 

1. Create a Venn Diagram in MS Word and have it 
ready to use. 

2. Have students come, sit and be ready to participate. 
Introduce the activity by telling students that they 
are going to watch two stories today and you want 
them to pay careful attention and be ready to talk 
about the stories. 
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11. Tell them that today we are going to talk about the main character. Explain that 

the main character is the one that the story is about. See if they can tell you 
Anansi, if not supply it. Open Kidspiration and type Anansi into the main symbol 
and then have them use their words to describe Anansi. Talk about the way that 
Anansi thinks and acts makes him unique. As you are doing this verbalize what you 
are doing on the computer so that kids learn how to work the program. 

12. Tell the students that they are going to get to describe a character that they 
would like to draw a picture of and tell a story about. Open a new Kidspiration. 
Change the font so that everyone can see the words and create lists of 
descriptive words that the kids might use in their own writing. 

13. To complete this activity have the students use the handout to draw their 
character. Then one at a time assist the students to come up and using 
Kidspiration, describe their character. 

 
 

Trainer: End of Activity Discussion Two Anansi Tales 
1. When the activity ends ask participants how they think their students would 

react to listening and watching a story in this way.  
2. Tell them that there is a lot of electronic literature available to them through 

the Internet and that tomorrow we will delve into the Internet and all that it 
offers as well as steps we need to take to protect our students. 
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1 computer 
classroom 
 
 
 

http://www.
bookhive.org
/zingertales
/default.asp
?storyid=17 
 
 
 
http://www.
bookhive.org
/ 
 
 
 
 
 
 
 
 
 
 
Venn 
Diagram in 
MS Word 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Open the first story “Anansi and the Two Feasts” 
and play the first story.  

4. Bring up the Venn Diagram. Tell the students that 
they just heard the first story and that you want 
them to think about the story and help to describe 
it. Introduce the Venn Diagram and type the word 
title of the story over one circle. Show them where 
the two circles overlap and explain to them that 
some things about the stories are different and 
some are the same. Tell the students that the parts 
that are different we will write in the part of the 
circle that is not overlapped. If the two stories 
have something in common we will put that in the 
area where the circles overlap. 

5. Open the second story which is “Anansi and the 
Shaking Hat Dance” and play it. Again talk with the 
students about what makes them feel scared. 

6. Bring the Venn diagram back up and then type the 
title of the second story over the second circle. 
Add 1-2 word descriptors of the items the students 
mention into the second circle. When the students 
bring up something that the stories have in common 
and make sure to put it in the right place.  

7. To finish the activity today review the Venn 
Diagram and read the words the students 
contributed. Quiz the students to see if they can 
read the words with you. Then tell the students 
that they are to choose a word and create a picture 
of something that makes them feel that way.  

8. On day 2 begin the lesson by asking the students 
which stories they read yesterday.  

9. Tell them that today we are going to talk about the 
main character. Explain that the main character is 
the one that the story is about. See if they can tell 
you Anansi, it not supply it. Open Kidspiration and 
type Anansi into the main symbol and then have 
them use their words to describe Anansi. Talk about 
the way that Anansi thinks and acts makes him 
unique. As you are doing this verbalize what you are 
doing on the computer so that kids learn how to 
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Kidspiration 
 
 
 
 
 
 
Additional 
Anansi Links 
 
http://www.
anansi.org/
webwalker/s
tory1.htm 
 
http://www.
anansispace
works.com/ 
 

work the program. 
10. Tell the students that they are going to get to 

describe a character that they would like to draw a 
picture of and tell a story about. Open a new 
Kidspiration. Change the font so that everyone can 
see the words and create lists of descriptive words 
that the kids might use in their own writing. 

11. To complete this activity have the students use the 
handout to think and draw their character. Then one 
at a time assist the students to come up and using 
Kidspiration, describe their character. 

12. Having students dictate a story is the next natural 
extension of this lesson. 
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Students will use the storyboard to draw their character. 
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Name_____________________________ 
 
M 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

My character’s name is 
 

______________________________________________________________________
__.
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 Venn Diagrams in Microsoft Word 
Step by Step 

Setting Up 
• Open Microsoft Word 
• Change the page layout 
• Click on the File menu and select page setup. 
• Click on the Paper size tab. 
• Under Orientation, click the bullet box beside Landscape. 
• Click OK. 
• Change the Zoom. 
• Click the drop down list indicator beside 75% on the right side of the toolbar.   
• Select 50%. 
• Make sure your drawing tool bar is showing. 
• Click on the View menu and select Toolbars. 
• If Drawing is not checked, click on Drawing.  If it is, click off. 
 

Making the Venn diagram 
• Draw a circle 
• Select the Oval tool on the drawing toolbar. 
• Hold the shift key while clicking and dragging a circle on the left half of the page. 
• Make a copy for a matching circle. 
• Click once on the circle to select it.  (It will have handlebars if it is selected.)   
• Right click and select copy. 
• Click off of the circle.  Right click and select paste. 
• Move the new circle over to the right of the page by clicking and dragging so that 

the new circle overlaps the original, allowing room to enter similarities in the 
overlapping area. 

• Set the Circle for No Fill. 
• Right click on the Right circle. 
• Select Format AutoShape. 
• Under Fill, beside Color: Use the drop down list indicator and select No Fill. 
• Click OK. 
• Draw lines for each animal name. 
• Select the line tool from the Drawing toolbar. 
• Hold Shift while you click and drag a straight line just outside of the upper left of 

the left-hand circle. 
• With the line selected (handlebars on each end of the line) click the Edit menu and 

select copy.  Click again on the edit menu and select paste. 
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• Click and drag the new line just outside the upper right of the right-hand circle. 
• Add text boxes 
• Select the Text Box tool from the Drawing toolbar. 
• Click and drag a text box above each label line, in each individual circle, and in the 

shared area.  Set the font style and size of your choice in each box.  (You will have 
to re-select the text box tool each time.) 

• Right click on the edge of each text box and select Format Text Box. 
• Under the line section on the Colors and Lines tab, change the color to No Line.  
• Click OK. 
• Add labels at the bottom of the diagram 
• Again select the text box tool from the Drawing toolbar. 
• Draw a text box under the left circle. 
• Set the font style and size and type “Different.” 
• Right click on the edge of the new text box.  Set the line color to No Line. 
• Draw 2 more text boxes; One for the middle section which will be “Same” and the 

other for the right-hand circle which will be “Different.” 
• Save the Venn Diagram as a template 
• Click on the File menu and select Save As. 
• Change Save as type to Document Template. 
• Change the file name to Venn Diagram. 
• Change the location to 3 ½ Floppy (A:) 
• Click Save. 
• Close out of Microsoft Word. 
 
Using the Venn Diagram Template 
• Open the Venn Diagram Template to enter information. 
• Double click on My Computer. 
• Double click on 3 ½ Floppy (A:). 
• Double click on Venn Diagram.dot 
• Click in the appropriate area to enter information. 
• Save the new Document 
• Click on the File menu and select Save. 
• Type in the name for the completed Venn Diagram. 
• Change to the appropriate drive and folder. 
• Click Save. 
• Close out of Microsoft Word. 
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Choosing Software 
Not all software is created equal. There are three broad categories of software that 
are used with young students.  
 
Productivity Software 
Software that allows students to write, draw, paint, and/or create. The software does 
not have a lot of specific activities that students do, but rather allows students to do 
all kinds of assignments all year long. 
 
Skills Oriented Software 
Software with specific activities that students do and progress through graduated 
levels. The software is limited in what you can do with it. The software may or may not 
include student tracking options or teacher customizing options. 
 
Subject/Topic Specific Software 
There is a lot of software that is designed to address a specific subject. The activities 
are all geared to developing ability in the subject. Frequently, the software combines a 
mix of games, multimedia, and activities. 
 
The advantage to using software with young children is that you have control over what 
is available to them. The disadvantage is that each software package provides only a 
limited amount of things for students to do. Before purchasing software, evaluate 
whether it will meet the needs of the kids in your class and for how long. The story CD 
that looks like a lot of fun may only have 5-6 activities, which only have 1 or 2 levels. 
The material provided may not fit with what you are trying to do. In a short period of 
time that software is no longer of interest to the students. Read software reviews and 
talk with colleagues before requesting new software titles. 
 
Kids Domain Software Reviews 
http://www.kidsdomain.com/reviews/listing.php?cid=software 
 
Super Kids Educational Software Review 
http://www.superkids.com/ 
 
Discover Channel Software Review 
http://school.discovery.com/parents/reviewcorner/ 
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Trainer Notes:  The diary activity assess participant’s thoughts and attitudes about 
curriculum and technology integration.  This activity is completed daily with a new 
question for reflection.   
 
Writing Topic for Day 1 Diary 

What did we do today that you would you like to try in your classroom? Did today 
give you any new ideas about technology and teaching with it?  
 

Small Group / Whole Group Sharing of Daily Diary 
• Move teams to small groups to discuss the diary reflection. 
• Small groups share whole group responses to the diary reflection. 
• Participants should print 2 copies of the daily diary.  One copy is submitted to the 

trainer and one is placed in their folder. 
• Use the student check sheet to check when assignment is complete. 

 
Trainer Notes: 

• Daily Diary whole group sharing is an excellent time for the trainer to address 
concerns of the participants.  Be prepared to listen carefully and respond 
positively when necessary.  Don’t let this turn into a gripe session. 
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Daily Diary 
 

 
 
 
 
Name: 
Date: 

 
 
Everyday you will be instructed to complete a “Daily Diary” entry. You will 
find the diary topic on the electronic bulletin board every morning. After 
you have written in and saved your diary, you will need to print 2 copies, one 
for your folder and one for your book. 
 
 
Today’s “Daily Diary” is  
 

 What did we do today that you would you like to try in your 
classroom? Did today give you any new ideas about technology and 
teaching with it? 
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Setting up a Eudora E-mail Account – Day 1 - page 42 
 

Trainer Notes – Assist participants in setting up an e-mail account.  Refer to the step-
by-step instructions to set up a Eudora account starting on page 42 of day 1. 
 
This email activity should be adapted for each trainer based on the email system that 
you use. 
 
Email is used daily with class participants.  Each morning, participants check their email 
for a message from the trainer.  They will need to answer a question that relates to the 
readings from homework and they will need to check the site of the day. 
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Setting up a Eudora E-mail Account 
 
Getting Started: 

 Open up your Internet browser. 
 Click in the Location Box to highlight the URL. 
 Type:  www.eudoramail.com 
 Press Enter on the keyboard. 
 Click on Sign-Up for your own free personalized E-

mail! 
 This will take you to Eudora Web Mail Terms of Use. 
 After reading (or not) the Terms of Use, click on “I 

Accept”. 
 
Setting Up an E-Mail Account: 

 Click in the box by User Name to place the cursor. 
 Type your first initial and last name (example: tsmith)   
 Press the Tab key to move to the next field. 
 Choose a password and type it in the Choose a Password box.   
 Press tab to get to the next field. 
 Type in the password again in this box.   
 Choose your time zone from the pull down menu. 
 Choose a password hint from the next pull down menu. 
 Click in the box below and type the answer to the question.   
 Press Tab. 
 Enter the necessary information in step 2.   
 All fields with a red dot are required fields and must be answered.   
 After completing all required fields, click on Register. 

 
Completing the E-Mail Setup Procedure: 

 Your assigned E-mail address will appear on the screen. 
 Type in your password and hit Enter. 
 This will take you to the Eudora Web-mail screen. 
 You will now be at the In-Box where you will receive your mail. 

 
Receiving and Sending E-Mail: 

 If you have new mail, it will be listed in the In-Box. 
 Click on the highlighted blue text to open your e-mail. 
 To send an e-mail, click on the New Message button at the top of your screen. 
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Setting up a Eudora E-mail Account – Day 1 - page 43 
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 Type in the Address of the person to whom you will send the message and 
press the Tab key. 

 Type in a Subject for the e-mail. Example: “Technology Training” 
 Click in the message box to place the cursor and start typing. 
 Do a Spell Check with the button at the bottom of the screen (scroll down). 
 After you have completed your e-mail message, click on Send. 
 You will receive a confirmation message. 
 Click on Inbox mailbox to return to the main screen. 

 
 

CC:  Stands for Carbon Copy- if you wish to send e-mail to several different 
people, list them in the CC section.  The other recipients will see a list of the 
people who received the message. 
 
BCC:  Stands for Blind Carbon Copy- If you wish to send e-mail to several 
different people, but prefer that they do not know who else received the e-mail, 
list them in the BCC section.  The recipients will not see a list of the other people 
who received the message. 
 
Attachments:  You can send a file along with your e-mail message.  Simply click on 
Attach File in your new e-mail message.  Click Browse to locate the file and then 
click attach. 

 
Replying to a Message:  If you would like to reply to a message sent to you, click on the 
reply button at the top and type your message.  A reply goes back to the sender.   
 
Forwarding a Message:  If you would like to forward a message to someone else, click  
the forward button at the top.  Forwarding a message just sends that same message 
that you received to a different person.  
 
Accessing Eudora Mail after registration: 
 

 Type in www.eudoramail.com in the location box of your Internet browser. 
 In the Registered Users box, under username, type your e-mail name. 

(example: tsmith) 
 Type in your password.  Press the Enter key. 
 You will be taken to the main screen where you can send and receive e-mail. 



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                  Trainers Manual  
 

Copyright  2004  i3 Training Services  Inc. 

File Management Help – Day 1 - page 44 
 

NOTES 
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File Management Help 
Keeping track of files can be challenging when you have many children on one computer 
or your students work both in a lab and in their room on computer. The following are 
some ways to manage this task. 
 
Set Up Folders on the Desktop for Different Subjects or Groups 

1. Close all programs and get to your desktop. 
2. Place your mouse cursor in the middle of the computer desktop. 
3. Right click and scroll to New and click on Folder. 
4. A folder will be placed on the desktop with the label highlight in clue and flashing. 

Type a name for a folder. 
 
Save Material into Folders Where Students Should Save their Work 

1. Create a document that you want the students to use and save it as a template 
into the folder where students will find it. Saving it as a template will prevent 
students from saving their work over the assignment. 

2. Teach students that when they open a document the immediately do a File Save 
As and put their number and name on it. Example 1Lynne 

3. When you open the folder all the students files should be in number order 
allowing you to quickly see who has not completed the assignment yet. 

4. If students can not yet type their name, open the template and save a copy of it 
with the student’s name into the folder. Then all the student has to do is open the 
document, do the assignment, save it and close it. 

5.  
Show Non-readers the Save Button 

1. When students are working there is nothing more discouraging than loosing their 
work. 

2. Show students the save icon on the toolbar and encourage them to use it often. 
 
 
 
 
 
 
 
 
 
 
 

Save Button 
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File Management Help – Day 1 - page 45 
 

NOTES 
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Show Non-readers the Exit Button 
1. Teach students early on that when the complete their assignment after they save 

they close it. 
2. Instead of having the students go to the File menu and drag down to Exit to close 

an assignment or program show then the X button. 
 
 
3. Students should get in the habit of leaving the computer the 

way they found it. 
 
When Assignments End Up Outside of Folders 

1. Click on the file, hold the left mouse button down and drag the file into the 
folder. 

 
When Assignments Get Lost 

1. Click on the Start menu and scroll up to Find. In Microsoft XP click on Start and 
then Search. 

2. Use either the name of the child as a search term or the date the student did 
the assignment. 

 
Use Experts 

1. If you are fortunate enough to have students who have computers at home or who 
are just comfortable on computers teach 2-3 to help with basic functions like 
saving and closing files. 

2. They in turn will train the next pair of students who will have this job.  
3. Make computer assistant part of the class job assignments. 
4. The next step in this process is to get the rest of the class used to asking these 

students for help. 
 
 
 
 
 
 

X Button 
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NOTES 



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                                       Day 1 
 

Copyright © 2004 i3 Training Services Inc.                       inspiring, innovative, integration      46 

Software List 
 
Graph Club 
Tom Snyder/Scholastic 
http://www.teachtsp.com/products/productdetail.asp?PS=GRPGRT 
Tom Snyder/Scholastic 
$799.95 site license 
 
Letter Machine 
Riverdeep/Edmark 
http://www.riverdeep.net/products/downloads/free_downloads.jhtml 
Free 
 
Kid Pix 
Broderbund 
http://www.kidpix.com/ 
$10.00-20.00 single user 
 
Kidspiration 
Inspiration             
http://www.inspiration.com/ 
Call: toll-free 800-877-4292        
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Trainer Notes – The Brain check is used to assess the participants’ knowledge of 
the use of the daily technologies.  This should be adapted by each instructor to 
match the selected software. 
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Brain Check 
 

1. Which program allows students to create graphs? How do you change the picture 
symbols in the program? 

 
 
 
 
2. What is one management technique that will help student know when their turn is 

on the computer? 
 
 
 
 

3. Which program allows students to draw pictures, stamp pictures and type words? 
 
 
 
 
 

4. Which agency has a position statement supporting the use of technology with 
young students? 

 
 
 
 
 
 

5. Which program was downloaded from the Web? What is one key thing to 
remember about downloading? 
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Daily Closure  
 

Trainer Notes –  
• Recap the day.  
• Take questions that participants have.  
• Assign Homework 
• Have participants straighten up their area. 
• Shut down computers 

 
 

 
End of the Day 

 Have people go into their email and have them reflect on the day and what pieces 
or ideas they would like to try in their rooms. They need to print the email and 
then send it to you so that you have all of their addresses and can send them a 
greeting in the morning. 

 Wind up the day by talking with them about how they are doing. Answer any 
questions they have. Then do the Brain Check on page 45 as a whole group. 

 
 
 

Be sure to end the day on a positive note!!! 
 




